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How to make a client resource

Plan
Make a plan with an overall          
aim, budget and timeline.        
Research best practices and       
review existing material.

Consult
a) Talk with community, clients                       
and other professionals.
b) Ask community for feedback                      
on your draft.

Draft
Draft your resource in  
plain language on the 
correct template.

Approve
Send your client resource to the 
communication team, they will                
check brand, language and spelling. 

Record
Record community feedback
on Riskman Q.
Log it on your team’s client                    
resource register.

PUBLISH

Step
1

Step
2

Step
3

Step
4

Step
5

For more information or assistance contact the communication team at 
communication@ipchealth.com.au
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About 
the health 
literacy 
guide

This guide will help you to produce professional 
and easy to read flyers, brochures, handouts, 
forms, letters, surveys and PowerPoint 
presentations for our clients.

We recognise that health literacy is a safety and 
quality issue in healthcare and we are committed 
to communicating and writing in plain language. 

Plain language is easy to read, understand and 
use. It avoids the use of complex sentences, 
phrases and jargon.

Writing in plain language supports and facilitates 
a person’s access, understanding and use of 
health information irrespective of their health 
literacy skills. It is important that the information 
we give clients is accurate, concise and in line 
with organisational policies.

All client resources produced by us should 
meet the health literacy guide standards. Using 
resources published by other organisations and 
peak bodies is allowed providing they meet our 
clients’ needs. All other materials should follow the 
corporate style guide.

Health literacy tools and  
resources on iNet

There are a range of health literacy resources   
and tools available on iNet for staff

How to find them:

1. Log on to iNet 

2. Click on ‘One-Stop-Doc-Shop’ on the               
left hand menu

3. Look under category > ‘Health literacy’
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Step  1       
                

Plan

 • Plan your time for consultation, drafting, 
approval, printing, translating etc.

 • Investigate clients’ needs. Then purpose 
and content of the resource

 • Consider developing a timeline and 
indicate potential costs 

 • Think about who you need to involve 
and how you will involve them:                   
clients, community, colleagues and   
other stakeholders

 • Get approval to undertake this work  
from your manager



6

Health  Literacy  Guide  -  Making  client  resources  easy  to  use  and  understand

Plan 
Written health resources must be simple and seek to empower people to 
take control of their health rather than just provide information. To create 
an effective resource, authors must understand their target audience, the 
intended goals for the resource, and the context it will be used in.

Investigate 
Consult your intended audience and your colleagues. Then take your idea 
and your plan to your manager for approval. 

Demonstrate that you have thought about the following:

1. Overview of the resource

• Does a similar resource already exist that can be used or adapted?

• What is the purpose of the resource?

• Who is the target audience? Why?

• Why is the resource needed?

• What are the three important messages?

• Will it need to be translated, if so in which languages?

2. Timeline 

There are many things to think about before you start drafting. The time 
required to do this will depend on the type and length of the resource.  
Allow adequate time for:

• Consultation with staff and community members

• Drafting the resource, getting photos and images

• Testing the resource with community members

• Getting it approved and printed

3. Anticipated costs 

With your manager, consider costs associated with:

• Translation

• Printing 

• Graphic design if appropriate and approved

The Communications team can help you investigate and plan your resource. 
Contact them by email at communication@ipchealth.com.au
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Investigate the topic
Whether you have identified a need for a new client resource or are reviewing 
an existing resource, you should investigate and research your topic.

Your investigation may include:

1. Searching existing literature and similar resources available on the topic

2. Reviewing professional recommendations and best practice 

3. Asking your colleagues, community, clients and carers:

• For their opinions/beliefs on the topic

• What information they would want to know?

• How they would like to receive the information?

For more information and tools to help you consult with community, clients 
and carers go to Step 2 - Consult (page 9).

Things to think about before preparing    
your draft
Limit the number of messages
Write only the key points of information that the reader needs to know.   
Give your audience no more than three or four main ideas in each section 
of your resource. 

Begin your resource with the most important information
To engage your readers quickly, give the most important information 
first, then tell them what action they need to take. Tell readers how your 
document will help them. Answer the question ‘What’s in it for me?’.

Focus on what your audience needs to know and do
Focus on what matters most to your readers. Address their issues and 
concerns as well as possible misunderstandings. For example, your 
readers don’t need to know how and when Lyme disease was discovered, 
instead tell them how to prevent it.

Organise your key messages in the order that your audience will          
use them. 

Stick to one idea at a time. Use headings and subheadings to highlight         
new information. 
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Printing 
Be aware that any colour in your draft will transfer differently when printed in 
black and white. 

Do a test print to make sure colour and margins are correct and of high quality.

• Colour printing is available at each campus. Ask a manager at your 
campus for the contact details of the nominated staff member. It may 
take up to three working days for colour printing to arrive to you once 
you’ve requested it.

• Professional printing - some resources may be printed externally. You 
need your manager’s approval and budget allocated to do this.

Getting resources translated 
English phrases can lose their meaning when translated into other languages. 
Therefore it is important that all client resources are first developed in plain 
English before being translated into another language. This assists the 
translation process.

We can translate some languages in house; others will be translated by an 
external agency. The cost is covered by the program that requires the resource.

Speak to your manager for more information.

Process for translating client resources: 

1. Follow the same process for developing client resources in English

2. Get your manager’s approval to translate the resource into                 
specific languages

3. Ask for a quote

4. Use a bi-lingual community member to test translated resources with the 
community who speaks this language 

Common pitfalls to avoid when having written resources translated:

• Be careful to not translate English slang phrases or idioms literally

• Do not translate into a dialect unless it is used by your audience

• Take care to not omit foreign language characters or accent marks used 
in that language. Missing characters or punctuation can change the 
meaning of a word or sentence

• If you list a phone number to call for more information also add that a 
phone interpreter can be organised 
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Step  2       
                

consult

 • Consult community to help you plan and 
develop the resource

 • Community members include anyone 
who lives, works, accesses services 
or studies in Brimbank, Hobsons Bay, 
Melton or Wyndham

 • Consult your colleagues and other 
stakeholders

 • Test the draft with community and 
clients, incorporate their feedback

 • Log community feedback on Riskman Q 
as a quality activity
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Consult community members
The best way to judge if your resource will be read, understood and if 
it meets the needs of your target audience is to plan it, develop it, and 
test it with them. 

Before starting a resource
Get an understanding of your target audiences’ values, their understanding of 
health and their cultural perspectives. This will help you draft a resource that 
meets their needs, is appealing and culturally specific. It will also save you 
time re-drafting and re-testing a resource. 

Ask community or clients about the topic. Find out if they would like to 
receive more information and how they would like to receive it: paper, 
electronic, video, images etc.

Test the draft resource with community
When testing the draft with community you are aiming to find out if it:

• Provides the reader with the information they need

• Helps them remember key points

• Is straight to the point, easy to understand and easy to use

• Is appealing and appropriate to them when considering age, gender    
and culture

Who should be consulted?
Members of the community who represent your target audience should 
be consulted. They will help you to develop resources that are culturally 
appropriate and presented in a way that will engage your target audience.

How many people need to be involved?
A minimum of 5 community members should provide their input or feedback.

Where can I recruit community members from?
• Use our community participation register

• Contact the community participation officer on 8368 3000

• Ask existing clients, carers and their families

• Utilise community groups 

• Ask organisations that work closely with your target audience for help
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How can I consult community for feedback?
Community can provide feedback via focus groups, surveys, or simply by 
asking them what they think (i.e. you may ask clients while they sit in the 
waiting room). 

The table below suggests the method you may use depending on the type 
of resource you are developing. 

Type of client resource Focus group Survey Ad hoc

Client forms - (e.g. consent) ✔

Testing usability of website ✔

Surveys or questionnaires ✔

Reports - (e.g. Quality of Care) ✔

Letter templates ✔ ✔ ✔

Handouts ✔ ✔ ✔

Flyers ✔ ✔ ✔

Service brochures ✔  ✔ ✔

Website pages ✔ ✔ ✔

Notes:  - Choose one of these methods. One method is sufficient

             - When existing resources are updated they should be retested

             - Surveys can be completed in person, online or by mail

What questions should I ask? 
Use the Community feedback survey (page 35) to guide your conversation 
with community members. The survey questions can be adapted for any 
type of consultation. 

Remember to:

• Explain who the resource is for and how it is given out to clients

• Give the ‘tester’ a colour copy of the draft resource

• Use the survey questions to guide your conversation 

• Write down or record their responses

In a focus group:

• Use open-ended questions

• Ask community to explain in their own words a section of the resource 

• Or act out a specific instruction, activity or exercise
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Focus group testing resources
You won’t get as in-depth information from survey or ad hoc testing as you 
will from a focus group. 

A focus group is a small group of people (minimum of 5 - 8) who come 
together with a facilitator to share their point of view on a topic. It is the 
preferred method of consultation as it encourages group discussion, problem 
solving and decision making. 

We recommend that all forms, surveys or questionnaires be focus group 
tested. This is to make sure they are easy for someone to fill out correctly.

Test usability of forms or questionnaires by asking the following questions:

• Which questions did you find hardest to answer? Tell me about that

• Which questions did you have difficulty answering?

• Were there any questions you felt uncomfortable about answering? 
Why?

• Were any of the multiple choice combinations missing an answer?

What do I do now with the community’s feedback?
Evidence of community consultation must be recorded for accreditation of 
the organisation’s quality and safety standards. 

Record the community feedback you receive. The evidence of community 
feedback and the resource are logged into Riskman Q as a quality activity. 

For more information, see Step 5. Record (page 32) and Tool 3 (pages 37).

Find more community consultation tools     
on iNet
Go to iNet > One-stop-doc-shop and you will find:

• Community feedback survey for client resources (page 35)

• Focus group guidelines – to help you plan a focus group discussion
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Step  3       
                

DRAFT

Client resources should be written in    
plain language

 • Test the readability of your draft in         
MS Word 

 • Readability score must be above              
60 out of 100

 • Reading level must be under school 
grade 6

 • Follow the design and formatting tips in 
this section and test the draft resource 
with community to make sure it is easy 
to understand
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Flyers and 
handouts

A4, A3 or larger - one/sided
A flyer is designed to promote a short 
term message such as advertising an 
upcoming group, event or program.

Service 
brochures

A4 - double sided, three folded
A brochure provides information 
about a specific service or program.

It can be used to provide more 
detailed information about a group, 
or event that cannot comfortably fit 
on a flyer template.

Information 
booklets

A5 booklets, folded
Reinforces information given in 
appointments or group sessions. 
Handouts can be developed in house 
or can come from other peak health 
bodies and organisations.

Powerpoint 
presentations

Powerpoint slides 
For tips on planning, developing 
and delivering your presentation, 
refer to the ‘Tips to improve your 
presentation’ skills kit, located on 
iNet.

Other If you need other resources please contact the 
Communication team by email at                   
communication@ipchealth.com.au

Templates for client resources
All client resources must be on our standard templates.

Templates are designed using evidence-based health literacy design 
principles; to maximise readability and to ensure consistent branding across 
all resources.

 

 ipchealth.com.au   Last updated xxxxxxxxxxxxx 
L 

TITLE 
 

Who should attend? 

Xxxxxxxxxxxxxxx 

 
What is it about? 

xxxxxxxxxxxxxxxxxxx 
 

 
 
 
 
 
 
 
 
 
 
 

 
Venue: xxxxxxxxxxxxxxx 
Dates:   xxxxxxxxxxxxxxxx 
 
  
Cost:  xxxxxxxxxxxxxxxxxxxx  
 
For more information: 
Call IPC Health on xxxxxxxxxxxxx and ask for xxxxxxxxxxxx or 
xxxxxxxxx. 

	 	

Title	here	  
 
	

	

  
Effective	April	2017	
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Templates can be found on iNet or in Microsoft Office
1. iNet home                                                                                                                  

- On the left side click on ‘Office templates’  

2. Microsoft Office application                                                                                 
• Open Word for flyers or handouts; Publisher for brochures; and     

PowerPoint for presentations

• Go to the File Tab > New > My Templates 

• Choose the appropriate template tab that you want.                                 
For example: Flyer, Handout, Brochure or ‘More’ to view all template   
folders at once.

• Use of staff names on client resources is not recommended however if 
required staff can use their first name on a client resource

• Use reception phone numbers or program intake phone numbers for 
bookings and as a contact point for further information

• Set a review date and include this in the footer 

• If the resource has been translated, state the language on the top right 
corner of the title page in English

• Ensure the disclaimer is included in the footer of clinical handouts

• Make sure the resource and its review date has been recorded in your 
program’s client resource register for quality control

Do not change the formatting on any 
template
Do not change the logo, margin widths, font or size, spacing 
justification or remove headings, picture frames from the templates. 
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Language
All client resources must be written in plain language. This is our minimum 
standard. Easy language is more appropriate for linguistically diverse clients.

Language level Examples

Complex

High school year 7       
and above 

Age: 13 years +

It is important that you read the notes, advice 
and information detailed opposite then complete 
the form overleaf (all sections) prior to its 
immediate return to the council by way of the 
envelope provided.

Plain

Primary school               
grade 6 and below

Age: 9 -12 years

Please read the notes opposite before you fill in 
the form. Then send it back to us as soon as 
possible in the envelope provided.

Easy

Primary school              
grade 4 and below

Age: 6-8 years old

• Read all the information on page 13

• Fill in the blue form

• Put the form in the envelope

• Send the envelope to me by                            
Friday 20 May 2005

The way you write, the formatting and the page design all contributes to your 
resource’s readability and language level. 

See page 18 for Tips on how to write in plain language and improve readability.

How to write in plain language
• Write as simply as you can

 − Be casual and conversational, write as you were speaking to the client

 − Call the reader ‘you’ and the organisation ‘we’ 

 − Try to use words with less than 2 syllables 

• Be clear and direct

 − Need to know information only

 − One idea per sentence

 − Give instructions that are actionable and number each step

• Be specific - state dates, times, size, and amounts

• Use positive language - tell the reader what they ‘can do’; avoid ‘don’t do’ 

• Explain - abbreviations, acronyms, difficult words or medical jargon
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Test readability in Microsoft Word 
Readability tests use mathematical logic to estimate the reading level 
of written resources and can be used as a guide to tell you if you are 
writing in plain language.

You can easily view your readability statistics in Microsoft Word. 

Every time you complete a spell check, a pop up box will provide you 
with your readability statistics.

Instructions to run readability test:
1. Open the ‘Review’ tab

2. Click on Spelling and Grammar

3. Complete the spell check and the pop up box with statistics will appear

Reading the scores:
1. Flesch Kinkaid Grade Level                          

Reflects school grades or year levels            
Grade 3 - 4 is easy language             
Grade 5 - 6 is plain language

2. Flesch Reading Ease                                                      
The closer to 100, the easier it is to read                                                  
Aim for above 60 out of 100  

If your statistics are not showing:

Apply automatic readability test settings

You only need to set up the settings once

1. Open Microsoft Word

2. Go to File> Options > Proofing

3. Tick the box that says ‘Show readability 
statistics’ and press the ‘Ok’ button
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Tips on how to write in plain language

Tip Explanation Example
Use words with 
a single meaning

People with limited 
literacy skills may not 
be able to figure out 
the meaning from     
the context.

‘poor workers’ could mean workers 
with poor performance or workers 
with limited income.

Choose words 
that your 
readers use

Pick the most familiar 
words that your 
audience uses. 

Ask your audience if they use the 
word: medication, medicine or drug.
Use the word they choose 
consistently.

Use doing 
words (verb) 
not phrases  
(phrasal verb)

Phrasal verbs are 
phrases that tell people 
to do something. Verbs 
are doing words.

 ✘  Make a choice                         
(phrasal verb is to ‘make a choice’)
 ✔ Choose                                         
(verb is ‘to choose’)

Action This is clear and direct 
and sounds less formal 
than the passive voice. 
Passive voice has less 
punch than active voice.

Instead of writing: Heart disease 
and lung cancer are caused by 
smoking.
Write: Smoking causes heart 
disease and lung cancer.

Tell readers 
what they need 
to do 

Clearly state what 
actions you want your 
audience to take.

Instead of writing: Following 
safety precautions can reduce 
food-borne disease transmission.
Write: Follow these rules to avoid 
getting sick from food:
• Cook meat until pink in the middle
• Wash your hands after touching 

raw meat
• Wash fresh fruits and vegetables 

before eating them
• Keep hot food hot and cold   

food cold

Be specific with: 
• Dates
• Time
• Size
• Amount

Avoid using terms 
that are open to 
interpretation or 
require judgement.
Such as: adequate rest 
or heavy lifting.

Try to get 8 hours sleep at night
and have a short sleep after lunch.

Use generic 
names of 
medications

When you refer to a 
medication include   
the generic and    
brand names. 

Acetaminophen, like Tylenol ®         
or Advil ®
Paracetamol, such as Panadol ®
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Tip Explanation Example
Limit use of 
quotation marks

Choose other formats 
to show who is speaking 
when writing dialogue.

Jane: How hard can it be to        
stop smoking? 
Ann: Most people have a very hard 
time quitting. I had to try three 
times before I quit for good.

Give context 
and explain  
new terms

Explain a new term or 
concept when you use it.
Continue to include 
some context to help 
readers remember what 
it means.

Eat foods that are high in 
fibre to prevent constipation. 
Foods that are high in fibre are: 
fruit, vegetables, legumes and 
wholegrain breads and cereals.

Respect your 
audience

Person before the 
condition or context.

Avoid blanket terms.

‘A person with diabetes’ instead of 
‘a diabetic person.’
‘A person experiencing 
homelessness’ instead of ‘a 
homeless person’.
‘Aboriginal and Torres Strait 
Islanders’ not ‘ATSI’ or    
Indigenous people

Use gender 
neutral terms 
where possible

Try not to assume      
the reader’s gender, you 
may leave someone out.

‘Partner’ – instead of wife or 
husband
‘Carer/s’ – instead of mother,  
father, parents
Use: you, we, they - your, our, their 
instead of: he/she, his/hers

Use two 
examples of 
measurements

Use two common ways 
to describe a specific 
measurement.
Spell out the measure 
and in brackets its 
abbreviation.

½ cup = 125 millilitres (ml)
5 millilitres (ml) = 1 teaspoons (tsp)
5 Centimetres (cm) = 2 inches (“)

Give a visual 
example of size 
that the reader 
will understand

Use similar sized objects 
that your audience will  
recognise.

Write: Feel for lumps the size of     
a pea. 
Instead of: Feel for lumps about    
5 to 6 millimetres in diameter.

Use words such 
as ‘chance’ or 
‘possibility’ 
instead of 
probability 
terms

Probability terms like: 
‘risk’ or ‘range’ are 
difficult to understand.

Write: There is very little chance 
of you getting sick from a vaccine.
Instead of: There is less then 5% 
risk of getting sick from a vaccine.

Use simple 
examples to 
demonstrate 
statistics

Use words like: most, 
many or half.
Demonstrate the 
number in clear manner.

Frequency (9 out of 10) is easier 
to understand than percentages 
(90%).
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Using inclusive language
Inclusive language promotes social inclusion; positive relationships; and  
plays an important role in acknowledging everyone and treating all      
people equitably. 

What is inclusive language?
Inclusive language is free from words, phrases and tones that belittle, 
exclude, stereotype or discriminate against people, on the basis of race, 
ethnicity, sexuality, gender, physical or intellectual ability, age,                   
socio-economic status or religion. 

Generally, descriptors that refer to these personal attributes tend to          
over-emphasize and draw undue attention to the distinguishing attribute.

It is a conscious effort to avoid stereotyping or marginalising people and 
plays a powerful role in eliminating discrimination. We are all responsible for 
using inclusive language to be accurate, fair and respectful.

How will I know if my language is inclusive?
It is useful to keep the following generic questions in mind: 

1. Is it necessary to describe individual or group characteristics such as: 
gender, sexuality, religion, culture, disability or age at all? 

2. Are descriptions of personal group characteristics stated in an 
inclusive and respectful manner? 

3. Have I made any generalisations, stereotypes or assumptions?

4. Do the descriptions of people reflect the complete diversity of the 
intended audience? 

As language is constantly evolving, it may be necessary to seek advice or 
more information for situations that are unclear. 
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Quick tips for inclusive language

Physical and 
intellectual 
ability

Use:

Barbara uses a 
wheelchair for mobility

Marcy is living with 
epilepsy

Individuals with 
schizophrenia

Avoid:

Robert is confined to a wheelchair

Marcy is afflicted with epilepsy

Schizophrenics

Culture, race 
and ethnicity

Be specific with 
racial, cultural 
and geographical 
descriptors

Use: 

Ethnic and racial groups

People born in Thailand 

Vietnamese-born 
Australian 

Iraqi Arabic-speaking 
Australian

Australians of Irish 
decent

English as an additional 
language

‘First name’ and   
‘Family name’

Avoid:

Ethnics or ethnic Australians

Umbrella terms like ‘Asians’  
ignores multiple ethnicities       
within Asia

NESB (Non-English Speaking 
Background)

ESL (English as a Second 
Language)

‘Christian name’ and ‘surname’ 

Aboriginal and 
Torres Strait 
Islanders

Use:  

Aboriginal and Torres 
Strait Islanders

Torres Strait Islander

Aboriginal

Aboriginal people

Indigenous Australians

Avoid:

ATSI; the Aboriginals; Aborigines

‘Islanders’  or ‘TSI’

‘aboriginal’ with a small ‘a’ 

A term generally used to describe 
indigenous people from around 
the world

Gender and 
sexuality

Use-neutral 
terms and 
pronouns to 
avoid assuming 
gender or sexual 
orientation

Use: 

Chairpersons;            
police officer

They or their

Ms and Mr

Partner or spouse

Parent or caregiver

Avoid:

Chairman; policeman

He / she  or  his / her

Miss, Mrs and Master

Husband / wife; boy / girlfriend

Mother / father or son / daughter
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Formatting text

Font Main heading:     Calibri size 22 

Subheadings:     Calibri size 16 
Body text:          Calibri size 14 

Colour Body text must be black on a white background
Colour can be used for appeal, in headings or to highlight 
sections. Use no more than 3-5 colours

Text must be much darker then the background
Used sparingly colour can help the reader navigate

Formatting Bold text for headings and important information only      
e.g. dates, addresses or phone numbers

Sentence case                                                                         
Start every heading and sentence with a capital letter, all  
other words in the sentence or heading are lower case

Bullet points and numbers break up lists of information

Use numerals rather than words use 99; not ninety-nine

Alignment Align text to the left Do not centre

Always position text and headings horizontally

Leave lots of white space
White space is the absence of text or images on a page and 
allows the readers’ eyes to rest between sections

• One third of your page should be white space
• Leave 2.5 cm of white space around the margins of the page
• Leave white spaces around elements (logos, graphics, tables)
• Space between paragraphs should be bigger than line spacing

Sentence 
Structure

Keep sentences simple and relatively short
Sentences should be no longer than 20 words
Limit paragraphs to 3-5 sentences

Lines of text across a page should have about 75-100 letters

Columns and tables - at least 5 words per line

Don’t break a word over 2 lines or a sentence over a page
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Page layout and design
Templates must be used for client resources (page 14) but for community 
reports, page layout and design are important considerations.

Use colour to highlight, emphasis and appeal
Used sparingly it helps the reader to scan and navigate the information and 
identify with the document. 

Disclaimers

Use the disclaimer found in client resource templates. Ask your manager if 
you need to add an acknowledgment. The disclaimer and review date should 
be located at the start of the document with the copyright or contents page. 

Heading in sentence case 22pt

Text body Size 14, text body text 
body text body. Text body text     

Subheading size 16
1. Step one 
2. Step two 
3. Step three and 
4. Step four

Text body text body text body
text body. Text body text body
text body text body text body.

For more information call            
8368 30000 or visit                   
www.information.com.au

We have given you this handout for your 
knowledge. We are not responsible for the 
way you may use this information. We ask 
you to use this information alongside 
professional advice or treatment.

Only 5 colours used 
including black    
and white

Colour of heading is 
re-used to highlight 
key information

Captions must be 
included for images 
and diagrams side

Important messages 
can be highlighted 
in text boxes or 
using side bars

Bold or highlight 
where the reader 
can get more 
information

Footer contains 
page number, 
review date and 
disclaimer.

Image
The most 
important 
point to 
remember

Second 
important 
point to 
remember
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Photographs Photographs are realistic and will help people 
identify with your message. 

• Use photographs that represent our clients

• Ensure the background isn’t too busy, 
drawing attention away from the image 

Written consent is required for photographs of 
staff, clients and community  

Find the consent form on iNet in the      
Consent for use of media policy.

Graphics Graphics act like photos, they provide detail 
and help people relate to the image. 

Best to show:

• Socially sensitive issues or concepts such as 
depression, addiction and diversity 

• Hard-to-see objects, e.g. bacteria

• Internal body parts like arteries. Show where 
it is in the body first to give context and 
location to the audience

Illustrations Illustrations simplify a complex idea.

Best to show:

• A sequence of instructions

• Posture or physical exercises

• Icon for instruction, e.g. telephone icon near 
phone number

Acknowledge the original owner of the   
image, by providing a reference.

Images, photographs and illustrations
Images convey information quickly and help people remember key messages. 

They should be used as educational tools and to engage or grab the reader’s 
attention, drawing them to the resource.

Monitor your blood sugar 
before exercise

Plaque build-up in the heart

Take one tablet with every 
meal and before you go     
to sleep
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How to use images
• Images should measure at least 3cm x 3cm on an A4 page

• Place images near related text

• White backgrounds are preferred or use minimalistic backgrounds that 
won’t distract from the main image

• Use circles (not arrows) to point out key information in your images

• Add labels that include your key message. Give one message per image

• Use images that are culturally relevant and familiar to your audience 

• Pay careful attention to the quality, size and placement of images 

• Draw small objects larger to show detail. Show size of the object next to 
something that is familiar to the audience

Images to avoid
• Avoid unnecessary detail 

• Show images of what ‘you want them to do’ rather than ‘what not to do’ 

Wear gloves to stop 
spreading germs

Eat more
vegetables

Don’t eat junk foodUse a non-stick pan

Use a non-stick pan

This is a mosquito
Enlarged for better detail Actual size against 10 cents
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Forms and questionnaires
Use the same design and language rules for forms and questionnaires while 
considering how to make it user friendly.

Introduction and instructions
• Explain who and what the document is for

• Define unfamiliar terms, jargon or acronyms

• Tell the reader how their responses will be used (protection of privacy)

• Give a contact for where they can get help or more information

Example: 

Layout
• Left aligned, Calibri size 14 font/readability score  60/100 and   grade 6 

• No more then 2 main columns

• Number questions and arrange them in a logical order

• Make sure that people know where to put their answers

• Provide plenty of space for people to write their answers

• Avoid using footnotes or asterisks

End of survey
• Tell reader what to do with the completed form or questionnaire 

• Thank your participant for completing the survey

• Provide a contact or website where they may get more information

Flu
This form is for people over 24 years of 
age. It will tell you if you can have a free 
flu shot at the clinic.

By filling out the form, you give us 
permission to use this information. 

We will keep this information private.

Start by reading Part 1.

Please give the form to the nurse, when 
you have answered all the questions.

The title immediately indicates 
the purpose of the form 

The purpose statement follows 
and conveys the full meaning of 
the original title without using 
difficult words

Consent and eligibility 
information should be at the 
top of the form or in the       
first question

Give enough instruction to get 
the reader started. Then add 
more specific instructions in 
each question

The last sentence tells people 
what to do with the form when 
they finish 
(Canadian Public Health Association, 1998)
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1. What is your address?

2. What would make it easier for you to use this service? Tell us below.

3. Is this your first visit? Please tick one box.  Yes  No

4. How important is each of the following to you? Tick one answer in 
each row.

Very 
important Important Neutral Less 

important
Not 

important

Clean waiting room     

Friendly staff     

Short waiting times     

Question format
• Use tick boxes if you want a ‘yes’ or ‘no’ answer

• Provide a large and obvious space for responses, you can use: 

 − A white box on a shaded background, with the question in the same 
box as the space for the answer. See the example below

 − Three row table with grey borders only on the bottom of each cell to 
create a line for writing. See question 4 in the example below

• Provide ‘don’t know’ options to stop readers guessing an answer

Ratings or scale questions
• Provide 3 or 5 response options with a ‘neutral’ option.                            

For example yes, no, maybe 

• Each response option must be clear and a specifically different measure. 
For example ‘bad and poor’ or ‘probably and probably not’ mean the              
same thing

• Only 3-5 questions should be places in one matrix. This makes it easier 
to read, easier to choose a response and means that the response 
options can be changed to be more specific to the question

Example: 
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Tables, charts and diagrams
Charts and graphs can attract attention and help people understand 
statistical information without having to interpret all the details.

• Make headings and labels specific and easy to understand. Label all axes

• Use rounded whole numbers and adjust ratios to the                          
smallest denominator

• Carefully explain calculations step by step

Line graphs
Trends over time
o 

Bar graphs
Comparing 2 or    
more things 
 

Pie charts 
Proportions or 
percentages

Pictographs
Frequency or 
prevalence  

When is the most salt added to our food?

■  Salt is found nautrally in food

■  Salt is added while cooking  
      or before eating

■  Salt is added during production to 
      make the food last longer

12%

11%

77%

How much sugar is in my drink?

Smoking rates in Australia from 1970 - 2015

Year

6 out of 10 people will need a blood tranfusion at least once in their life
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Step  4 & 5

APPROVE
RECORD

 • Use the Health Literacy Checklist to 
ensure your resource aligns with this 
health literacy guide

 • It is important for every team to have 
systems in place for tracking the review 
and development of client resources

 • Community feedback can be recorded 
in Riskman Q and used as evidence for 
accreditation of the organisation’s quality 
and safety standards
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Approval process
Use Tool 3 Health Literacy Checklist (page 34) to ensure your resource 
aligns to the health literacy guide.

Staff should provide Communication team checks

Template, branding                 
and formatting

Readability scores

Readability is greater               
than 60 out of 100 and        

under Grade 6

Evidence of                  
community feedback

Community feedback is 
satisfactorily incorporated

Media consent forms
Information, grammar                 

and spelling
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Who is responsible for approving client 
resources?
The IPC Health communication team is responsible for approving client 
resources. 

They will ensure that your resource has the correct:

• Templates, brand and formatting

• Spelling, grammar and readability

• Suitability for community 

You can contact the communications team to assist you at any point of your 
resource development. For example, they can assist you in determining aim 
and target group of your client resource and have access to photographs 
and other images that you can use. 

How do I ask for approval?
Ask for approval by emailing communication@ipchealth.com.au

You should provide the following: 

1. Final draft of your resource 

2. Readability scores: reading ease and reading grade 

3. Evidence of community feedback. For example, copies of surveys 
completed by clients or focus group meeting minutes summarising the 
key feedback/changes suggested by community 

4. Electronic media consent forms for photographs used 

Prepare the final draft for approval
Use Tool 3 - Health literacy checklist (page 34) to ensure the resource follows 
the health literacy principles outlined in this guide.

Also check that the: 

1. Correct template, branding and formatting has been used 

2. Readability score is greater than 60/100 and reading grade is under 
grade 6 

3. Community feedback has been satisfactorily incorporated into the 
resource 

4. Information, grammar and spelling are correct
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Quality control of client resource
All teams are responsible for developing and maintaining client resources 
that are current, appropriate, and easy to understand. This is our 
commitment to best practice and continuous quality improvement and 
allows us to be responsive to our clients’ needs.

Developing client resources in collaboration with community is one aspect of 
the quality and safety standards that we must report on for accreditation.

• Quality Improvement Council                                                            
Standard 2. Providing quality services and programs

• National Safety and Quality Health Service Standards                
Standard 2. Partnering with consumers

Therefore it is important to track and record our progress in this area.

Below are some ideas of what your team could do.

Keep records of your client resources
• Store all client resources electronically on a central drive                   

Your team can agree on an appropriate filing system

• Make a client resource register                                                               
Log all of the team’s client resources, date of next review, other 
important information to support your team to monitor quality control.

• Develop a Riskman Q quality activity page for client resources      
Record evidence of community feedback and readability scores of each 
new or updated resource each year. These will later be used as evidence 
towards accreditation

Instructions:

 − Create one quality activity page each calendar year

 − Record new and updated resources as a new journal entry

 − Attach the final draft and evidence of community feedback in the   
 document section

For more information see: 

Tool 4 - How to enter community feedback into Riskman Q (page 37) 
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Tool 1 Health Literacy checklist 

Tool 2  Community feedback    
 survey for client resources

Tool 3 How to log community    
 feedback into Riskman Q

TOOLS

33
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Tool 1

Health literacy checklist 

Readability score is  ______  / 100       Reading grade is  ___________ 

Aim for a readability score above 60/100 and a reading grade under grade 6.0

Content 
  Purpose is clear

  Title conveys your main message

  Only 3-5 messages per resource

  Content does not distract from the  
 key messages or purpose

  Chunk information using headings  
 and subheadings and bullet points

  Include a contact or website to  
 find out more information 

Plain language 
  Use common words 

  Use short words (2 syllables) 

  Use conversational language            
 e.g. you, we, they; your, our, their

  Use short sentences 

  Put the action or verb before the  
 object in a sentences 

  Avoid jargon and acronyms

  Complex or medical terms are  
 explained

  Use encouraging and positive words 

  Person before condition                    
 e.g. Person with a disability

  Avoid judgement or blame

 Avoid using ‘should’ and ‘must’

Numbers
 Numbers are clear and easy to  
 understand

 Use numerals (5), not text (five)

 Statistics are easy to understand

Text appearance
 Calibri  size 14  for text body                
  size 16 for subheadings       
  size 22 for page titles

 Use sentence case

 Text justified to the left, not centred

 Use colour and bold text sparingly  
 to highlight key information

 No words in CAPITALS or underlined

Design and layout 
 Margins 2.5 cm

 Has a light background and dark text

 Use no more the 3-5 colours    
 (including black and white paper)

 Only 5 bullet points at a time

 Every step of an instruction is  
 numbered

 Information is in a logical order

 Context is provided before   
 introducing new information

 There is plenty of white space

Images and diagrams
 Appropriate images are used to  
 demonstrate instructions or for  
 audience appeal

 Images at least 3cm x 3cm

 Images places adjacent to text 

 Images used to reinforce text 

 Use titles and captions to explain  
 images, tables, graphs and diagrams

 Give instructions on how to read  
 charts and graphs
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Name: Date:

Phone: Email:

Can we contact you by phone or email            
if we have more questions?

 Yes  No

Please write down your thoughts for the following questions

Is English your first language?  Yes  No

Is the resource easy to use?  Yes  Somewhat  No

Is the font large enough to read?  Yes  Somewhat  No

Is it easy to understand?  Yes  Somewhat  No

Was the information helpful?  Yes  Somewhat  No

Does the order make sense to you?  Yes  Somewhat  No

Was the resource interesting to 
look at (pictures, use of colour)?

 Yes  Somewhat  No

Were images clear to see?  Yes  Somewhat  No

Did you understand what the 
image was trying to convey?

 Yes  Somewhat  No

Please write down any comments or suggestions below.

Community feedback survey for client resources

Tool 2
35
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Please write down your thoughts for the following questions

1. What did you think was the main message of the resource?

2. What parts of the resource did you find the most useful?

3. What parts of the resource did you find the least useful?

4. Is there any other information you would like included?

5. Do you have any other ideas to improve this resource?
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How to log community feedback into 
Riskman Q 
Community feedback on client resources should be logged into Riskman Q as a 
quality activity. This information will later be used as evidence in accreditation.

You only need to set up one quality activity per calendar year. 

Each resource that community review in that year is then added as a ‘New 
Journal Entry’ and the resource and evidence of community feedback is 
attached in the document section.

Start a new quality activity page: 
1. Log in to Riskman Q > my workspace > new > quality activity

2. Complete all of the yellow fields as appropriate                                                             
Each year you can reuse the information in the example below to describe 
your new quality activity. Just make sure to change the dates. 

Enter a new resource and community feedback: 
1. Log in to Riskman Q > my workspace > review my > quality activity

2. Open the current year’s quality activity page 

3. Complete a new journal entry. For journal type select ‘Task’

4. Attach the resource and evidence of community feedback under          
‘Add Documents’

Example: this is what the quality activity page will look like

Tool 3

Activity Details

Activity Title 2016 Community consultation on client resources

Activity Aim For community members to review new or updated client 
resources to ensure they are appropriate, easy to read and 
use. Methods used include but not limited to: focus group 
testing, surveys or informally asking clients or community 
for their feedback. Each client resource that is reviewed will 
be added to this quality activity as a New Journal Entry, and 
in the documents section the client resource and copies of 
community feedback will be attached.  

Anticipated 
Outcomes

Resources developed in consultation with or user tested by 
community will more appropriately meet the needs  and 
expectations of community and/or clients.

Methodology Assessment

Consumer/ Community Consultation

Activity Reason Consumer feedback
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